
List of Features in EES by version number and date 
 
 
Versions 6.585  8/25/02 
Right-clicking in the header cell of a table column brings up a pop-up menu with Properties as one of the 
menu choices.  Selecting Properties will now display the Sum, Average, and Std. Deviation of the values in 
the selected column, in addition to the units, format, and other information related to the column. 
  
Version 6.581  8/19/02 
The $Bookmark directive provides a means of quickly moving to selected locations in the Equations and 
Formatted Equations windows.  The bookmarks can be accessed from the lower part of the Search menu 
and the popup menu that appears when the right mouse button is pressed.  Several bookmarks have been 
added to this file, for illustration.   
 
Version 6.575  8/05/02 
The $TABSTOPS directive allows up to 5 tab stop positions to be set.  These tab positions affect the 
appearance of text in the Equations window.  In addition,up to 5 default tab stop positions can be set in the 
Equations tab of the Preferences dialog in the Options menu.  The $TABSTOPS directive overrides the 
setting made in the Preferences dialog.  The $TABWIDTH directive is superceded by the $TABSTOPS 
directive, but it is still accepted. 
 
Version 6.573  8/04/02 
Formally, error bars could be drawn on plots only for variables involved in the Uncertainty Propagation Table 
command.  Now, error bars can be placed on any plot by clicking on the X-axis or Y-axis check box in the 
Error Bars box of the Modify Plot dialog.  The Modify Plot dialog is presented when the user right-clicks in the 
plot rectangle or when Modify Plot is selected from the Plot menu.  
 
Version 6.568  7/29/02 
Property data for Deuterium have been implemented. 
 
Version 6.566  7/27/02 
Functions SUMLOOKUP and AVGLOOKUP have been added. 
 
Version 6.564  7/25/02 
Functions SUMPARAMETRIC and AVGPARAMETRIC have been added to sum or average the values in all 
or selected rows in a specified column of a specified Parametric Table.  The online help provides the syntax 
for these functions.  
 
Version 6.561  7/19/02 
The Solution window is accessible after the Solve command is issued even if the solution is not attained.  In 
this case, however, some variables are not evaluated.  The variables that are not evaluated are now shown 
in gray color in the Solutions window. 
 
Version 6.552  6/27/02 
If EES is launched from the command line with the /NOSPLASH parameter, the splash screen will be 
skipped, as in the following example:   
C:\EES32\EES.exe C:\EES32\HELLO.ees /NOSPLASH 
 
Version 6.547  6/21/02 
A short (up to 255 character) description of the contents of a plot window plot to be entered in the Plot Setup 
dialog.  The description can be printed with the plot. 
   
Version 6.543  6/19/02 
A Calculator window has been added, accessed from the Windows menu.  The Calculator window evaluates 
one-line expressions involving numbers, existing EES variables or any of the built-in functions.  See the 
online help for details. 
 
Version 6.538  6/12/02 
Variable information can  be used to set the units and display format of variables in internal Functions and 
Procedures, in addition to those in Modules, Subprograms, and the Main Program. 



 
Version 6.533  6/06/02 
Error messages that are displayed when EES cannot converge to a solution have been improved and linked 
to Variable Information for the variables that are causing the convergence problems. 
 
Version 6.530  5/29/02 
EES plots can now be saved in a separate file in bitmap (*.bmp), jpeg (.jpg), picture (*.wmf) or enhanced 
metafile (*.emf) formats by right-clicking on the plot tab and then clicking the Save button. 
 
Version 6.527  5/25/02 
Text items placed in the plot windows can contain up to 240 characters (previously 80) and have more than 
one font applied to selected parts.  A single text item can also span multiple lines.  The formatting is 
facilitated by speed buttons in the Format Text dialog that appears when you double click or right click on a 
text item in the plot window.    
 
Version 6.516  5/11/02 
Tabs on the plot and table windows can be given a background color by right-clicking on the tab. 
 
Version 6.514  5/08/02 
A line of descriptive text with up to 255 characters can be entered for each plot window and for each 
Parametric and Lookup table by right-clicking on the tab at the top of the window.   The text can optionally be 
printed when the table or plot is printed. 
 
Version 6.504  4/28/02 
The Windows menu now provides submenus for the Plot window and for the Parametric and Lookup tables if 
more than one plot or table is contained in the window. 
 
$Bookmark Version 6.501 
Version 6.501 and 6.502  4/23/02 
The operation of the Variable Information dialog has been changed.  Calculated values of variables were 
displayed in place of the guess values if the value was previously determined.  Now the guess value is 
always displayed.  However, right clicking in the Guess column will change the display from Guess values to 
current values.  Provisions have been made to copy cells in this dialog to other cells more easily.  For 
example, a 'drag box', similar to that used in EXCEL has been implemented to allow the contents of a cell to 
be copied to a range of cells above or below it.  See the online help for details. 
 
Version 6.498  4/18/02 
Right-clicking on the row column in a Parametric or Lookup table will bring up a popup menu that allows rows 
in the table to be inserted or deleted.  It is now possible to control the number of rows that are inserted by 
selecting the number that you wish to insert.  Selection of rows can be made by holding the mouse button 
down and dragging it to a new position in the row column. 
 
Version 6.497  4/17/02 
After calculations are completed, selecting a variable in the Equations window will cause its value and units 
to be displayed in a 'hint' window below the cursor.  The variable can be easily selected by double-clicking.  
This capability makes it unnecessary to refer to the Solutions window to determine values of EES variables. 
 
Version 6.490  4/09/02 
Thermodynamic and transport properties for cyclohexane have been added. 
 
Version 6.489  4/07/02 
The 'hot area' that brings up a child Diagram window when it receives a mouse click can be moved with 
arrow keys in development mode if the Ctrl-Shift keys are depressed and the mouse cursor is positioned in 
the red-dotted rectangle that displays the boundary of the hot area. 
 
Version 6.485  4/04/02 
Unit checking for selected equations can be disabled in the Residuals window or in the Check Units window 
by right-clicking on the equation and selecting Disable Unit Checking from the pop-up menu.  
  
Version 6.480  3/30/02 



Differentiate1 and Differentiate2 commands have been added that use linear and quadratic interpolation, 
respectively, in estimating a derivative. 
 
Version 6.476  3/26/02 
Tabs can now be set in the Diagram window formatted paragraph text.  The width of this text can be set to 
grow or shrink with the width of the Diagram window. 
  
Version 6.467  3/18/02 
Property data for HFE7100 have been added. 
 
Version 6.461  3/11/02 
Units raised to a fractional power are now recognized, e.g., [ft^(2/3)] 
 
Version 6.454  3/01/02 
The GAMMA_ function has been added as a built_in mathematical function. 
 
Version 6.450  2/23/02 
The uncertainty values used in the Uncertainty Propagation and Uncertainty Propagation Table commands 
can now be supplied as numerical constants or as EES variables.  In the Uncertainty Propagation Table 
command, the EES variable must have specified values appearing in the Parametric table. 
 
Version 6.446  2/20/02 
The Uncertainty function has been renamed to UncertaintyOf and its capabilities have been improved. 
 
Version 6.444  2/18/02 
The Warnings menu item in the Windows menu will produce a display of all warnings issued during the last 
calculation. 
 
Version 6.440  2/15/02 
The % of uncertainty in a calculated variable resulting from the uncertainty in each measured variable is 
displayed in the Solution window after the Uncertainty Propagation or Uncertainty Propagation Table 
calculations are completed. 
 
Version 6.430  2/2/02 
The units of an external function can be set, as in the following simple example. 
 
 Function TK(TC) 
    TK=TC+273.15 "[K]" 
               end 
 
Function TK can be saved in a .LIB file in the USERLIB directory.  It will be read in automatically when EES 
is started.   When called, the function will return a value having units of K.  The Solid/Liquid property 
functions use this capability. 
 
Version 6.425  1/28/02 
Substance Ice provides the same properties as Steam, Steam_NBS, Water and R718 except that it will 
return the state corresponding to a lower  temperature when two solutions are possible, as in the following 
example. 
 
 T_ice=temperature(Ice,v=1.088e-3,x=0)    {T_ice=-16.85 [C]} 
 T_steam=temperature(Steam,v=1.088e-3,x=0)  {T_steam=147.8 [C]} 
 
Version 6.424  1/28/02 
The tab spacing in the Equations and Formatted Equations windows can be changed in the Preference 
dialog (Equations tab) or with the $TabWidth directive. 
 
Version 6.423  01/24/02 
Substance Steam will return properties for ice for temperatures below 273.15 and pressures above the 
saturation vapor pressure of ice.  Note that substance Steam_IAPWS will not provide ice properties. 
 



Version 6.421  01/22/02 
A Retry button and other improvements have been added to the Curve Fit dialog for a user-entered 
functional form. 
 
Version 6.419  01/21/02 
Property data for refrigerant R-508B (DuPont SUVA 95) have been implemented. 
  
Version 6.418  01/20/02 
The Unit System dialog provides additional options when SI units are selected.  Pressure can be in Pa, kPa, 
bar, or MPa units.  Energy units can be in Joules or kJoules. 
 
Version 6.412  01/10/02 
In the Professional version, the information in drop-down lists that appear in the Diagram window can be 
read from a file.  
 
Version 6.410  01/01/02 
Psychrometric charts produced with the Property Plot command now offer the option of constant specific 
volume lines. 
 
Version 6.406 12/21/01 
The default reference state for R134a has been set to the ASHRAE reference.  Steam_IAPWS is now 
accessible in the academic version. 
 
$Bookmark Version 6.402 
Version 6.402 12/16/01 
Fluids R22, R134a, Ammonia, and Propane have been renamed to R22_old, R134a_old, Ammonia_old, and 
Propane_old, respectively.  Fluids R22_ha, R134a_ha, Ammonia_ha, and Propane_ha have been renamed 
to R22, R134a, Ammonia, and Propane, respectively.  This change now results in the high accuracy property 
formulation for these fluids being the default.  R717 is equivalent to Ammonia, and R290 is equivalent to 
Propane.   
 
The $Reference directive allows the reference state for enthalpy and entropy for fluids with properties 
determined using the high accuracy equation of state to be set.  See the Fluid Property Information in the 
online help to determine which fluids are represented by high accuracy equations of state.  The available 
settings are DFT (default), NBP (set enthalpy and entropy to 0 for saturated liquid at the normal boiling 
point), ASH (set enthalpy and entropy to 0 for saturated liquid at -40°C (°F)) and IIR (set enthalpy=200 kJ/kg 
and entropy=1 kJ/kg-K for saturated liquid at 273.15 K).  See the online help for $Reference for more details. 
 
Version 6.395  12/10/01 
Holding the Shift and Ctrl keys down while the cursor is positioned on a plot produced with the Property Plot 
command now shows 
all thermodynamic properties corresponding to the state at the cursor position in the window caption. 
 
The OverlayPlot and NewPlot Macro commands can specify SymbolSize 
 
The PropertyPlot macro command allows the pressure to be specified for psychrometric plots. 
 
Version 6.386  12/01/01 
The Print command can now select individual tabbed Solution windows for printing. 
 
Version 6.385  11/30/01 
The unit checking algorithms will now accept units raised to fractional powers, e.g., [K^0.5]" 
 
Version 6.384  11/29/01 
Units in Functions and Procedures in the Solution window are shown in alphabetical order.  
 
Version 6.380  11/26/01 
Unit checking will now occur for equations in Functions and Procedures.  Units for variables in Functions and 
Procedures can be entered either as a comment in the Equations window or by right-clicking on the variable 
in the Solution window.  Note that the variables in Functions and Procedures will not be displayed in the 



Solution window unless the "Show Function/Procedure/Module values" checkbox in the Options tab of the 
Preferences dialog is enabled or a $LOCAL ON directive appears in the Equations window. 
 
Version 6.374  11/17/01 
The speed button bar below the menus now provides a button to access the Residuals window. 
 
If Automatic unit checking is set in the Preferences dialog or with the $CHECKUNITS directive, the Solution 
window will indicate the number of equations that fail the unit checking test.  The Residuals window will 
display a column indicating whether the units for each equation check.  Right clicking on an equation in the 
Residual window will bring up a popup menu.  One of the menu options is to display the message from the 
unit checking processor.   
 
Version 6.370  11/13/01 
The $CHECKUNITS ON/OFF overrides the automatic unit checking setting in the General tab of the 
Preferences dialog. 
 
Version 6.361  11/04/01 
The Convert function will accept unit groups in parentheses raised to a power, as in the following:  
X=convert((m/s)^2,kJ/kg) 
 
Version 6.353  10/27/01 
A dot, bar or hat can be placed over a selected character(s) on plot text items.  The procedure is to first 
select the character(s) and then press and hold the symbol speed button while sliding the mouse to the 
X_dot, X_bar or X_hat symbol in this pop-up palette.  
 
Version 6.351  10/23/01 
Fugacity has been added to the built-in thermophysical properties functions. 
 
Version 6.346  10/17/01 
High accuracy thermodynamic and transport  property data for xenon have been implemented. 
 
Version 6.343  10/15/01 
High accuracy thermodynamic and transport data for air have been implemented.  In the two-phase region, 
the saturation temperature of air varies with quality at a given pressure. 
 
Version 6.342  10/11/01 
High accuracy thermodynamic and transport  property data for R125 (pentafluoroethane) have been 
implemented. 
 
Version 6.337  10/03/01 
The $SumRow On/Off directive allows the visibility of the sum row in Parametric tables to be controlled from 
the Equations window.  The values in the sum row can now be copied to the clipboard. 
 
Version 6.330  9/22/01 
Latex Solution and Table windows can now display background colors. 
 
Version 6.310  8/26/01 
The $Private directive has been implemented to prevent external routines from been seen from in the 
Function Information dialog.  The online-help provides details. 
 
Version 6.303  8/18/01 
A column of strings from the Parametric, Lookup or Arrays table can be selected as the X-axis variable for X-
Y and bar plots.  The X-axis will then display the strings rather than numerical values.  
 
$Bookmark Version 6.300 
Version 6.300  8/15/01 
Surface tension correlations have been implemented for blends R404A, R407C, R410A, and R507C. 
 
Version 6.298  8/14/01 



The Uncertainty Propagation dialog has been modified to allow additional variables to be included as 
"Measured" variables.  See the on-line help for details. 
 
Version 6.295  8/11/01 
The Interpolate2D function provides interpolation as function of two independent variables using a radial 
basis functions.  Details are available in the on-line help.  An example is provided in the Interpolate function 
menu item of the Examples menu. 
 
Version 6.294  8/08/01 
Transport property data for Helium have been extended and improved. 
 
Version 6.290  8/05/01 
Right-clicking the tab on Lookup and Parametric table windows displays a dialog with table properties.  A 
duplicate button has been added to this dialog to facilitate making copies of tables. 
 
Version 6.284  7/28/01 
$Include directives may be used in drop-down string lists in the Diagram Input to selectively add EES 
equations that depend  on a user choice.  This capability eliminates the 255 character limitation on the 
number of equations that can be entered from the Diagram window.  An example titled "Using the Diagram 
Input capability with $Include files" is available from the Examples menu with the Diagram Window menu 
item. 
  
Version 6.280  7/27/01 
The New Parametric Table dialog now provides a check box to show or hide array variables from the list of 
variables that can be selected to include in the table. 
 
Version 6.277  7/24/01 
SoundSpeed has  been implemented for substances Water, Steam, and Steam_NBS. 
 
Version 6.274  7/22/01 
Warnings are issued if the Interpolate, Interpolate1, or Interpolate2 functions are applied to extrapolate data.  
The warning message list is cleared during each iteration so that warning generated as a consequence of  
intermediate results are no longer displayed.  The LookupCellEmpty function has been implemented. 
 
Version 6.270  7/19/01 
The Function Information command now provides a Solid/Liquid properties button to allow more convenient 
access to the temperature-dependent properties of solids and liquids implemented in the Solid-Liquid library 
package. 
 
Version 6.265  7/13/01 
Controls are now provided to show or hide array variables in the Min/Max dialog.  
 
Version 6.262  7/10/01 
Array range notation with variable limits is now supported in Function and Procedure header statement.  For 
example, EES accepts,  
  Function TEST(n, X[1..n], y) 
In this case n is assigned a default MAXIMUM value of 100.  The calling program must provide the maximum 
or fewer elements in the array.  To increase the maximum, change the n in 1..n to the desired maximum.  
See the online help under Array Range Notation for details. 
 
Version 6.260  7/08/01 
Formatted text can be placed in the Diagram and Child Diagram windows in the Professional version.  
Formatted text can include paragraphs or tables copied from other applications.  EES variable information 
can be inserted into the formatted text item.  See the online-help and the example file in the Diagram menu 
item of the Examples menu for details. 
 
Version 6.254  7/01/01 
The algorithms invoked with the Check Units command can now evaluate equations that have variables 
raised to fractional powers. 
 



Version 6.252  6/29/01 
Richardson extrapolation is now optionally provided for integration with a fixed step size.  The option can be 
set on the Integration tab of the Tolerances dialog in the Options menu.  The on-line help provides additional 
information. 
 
Version 6.247 6/17/01 
Property function ACENTRICFACTOR requires one argument which is the name of the fluid.  It returns the 
acentric factor for that fluid.   
 
Version 6.245  6/16/01 
Copying and pasting large amounts of data to any of the EES tables was previously very slow.  This problem 
has now been rectified. 
 
Version 6.243-4  6/14/01 
The temperature range for the ideal gas transport properties of air, H2, O2, N2, CO2, CO, and CH4 have 
been extended. 
 
Version 6.239  6/09/01 
Data in the Parametric and Lookup tables can be sorted in ascending or descending order by right-clicking in 
the column header cell and selecting Sort from the pop-up menu. 
 
Version 6.235  5/30/01 
The $LOCALVARIABLES ON/OFF directive controls the display of local variables (in Functions, 
Procedurses, Modules, and Subprograms) in the Solution and Residuals windows.  This directive overrides 
the setting in the Preferences dialog. 
 
Version 6.234  5/29/01 
It is now possible for a Function or Procedure to call a Subprogram.  A Subprogram is a stand-alone EES 
routine that can be accessed with the CALL statement.  Functions and Procedures can use logic statements.  
The ability of Functions/Procedures to call a Subprogram increases the range of problem types that EES can 
solve.  See the online help for details.  
 
Version 6.231  5/26/01 
In the Residuals window, bold block numbers are used to identify equations that were not solved to the 
specfied tolerance. 
  
Version 6.226  5/22/01 
Ideal gas property data for C2H5OH (ethanol) have been implemented. 
  
Version 6.224  5/21/01 
3-D plotting has been implemented for the Professional and academic versions.  See the online help (topic 
X-Y-Z plot) for details. 
  
Version 6.220  5/14/01 
An option to specify specific pages or a page range has been implemented in the Print dialog.    
 
Text and objects drawn (or imported) in a Plot window can be copied to the Plot window of another instance 
of EES.  Objects (e.g, lines, boxes, pictures) can be copied to/from the Diagram windows. 
 
Version 6.218  5/12/01 
When using the Uncertainty Table command, the sum row in the Parametric table will display the uncertainty 
of the summed values which is the square root of the sum of the squared uncertainty values from each row.   
 
Version 6.213  5/03/01 
The Modify Plot dialog now permits the size of major and minor ticks in Plot windows to be changed.   
 
Version 6.212  4/29/01 and 02/20/02 
An UNCERTAINTYOF function has been implemented to return the specified or calculated uncertainty for 
the variable provided as the argument to the function.   For example, RUX=UncertaintyOF('X')/X will set the 
value of RUX to the relative uncertainty for variable X.  The UNCERTAINTYOF function will return a non-



zero value only when the Uncertainty Propagation or Uncertainty Propagation Table commands (Calculate 
Menu) are used.  
 
Version 6.210  4/26/01 
It was necessary to change the calling parameters of the .DLF and .DLP external routines so that these 
types of dynamic link library files can be written in C++ (which  no longer supports the long double format).  
All of the .DLF and .DLP files in the USERLIB folder have been updated.  You will have to modify any .DLF 
or .DLP files you have composed.  See the on-line help for External Functions and External Procedures for 
details. 
 
Version 6.209  4/24/01 
A Library Manager has been implemented in the Professional version.  The Library Manager controls which 
files are automatically loaded from the USERLIB folder when EES is started.  Access to the Library Manager 
is from the Function Info command by pressing the Auto Load button when either EES Library Routines or 
External Routines is selected.   
  
Version 6.208  4/22/01 
Circles and rectangles that are drawn on the plot or diagram windows can now be transparent. 
  
Version 6.205 4/19/01 
In some situations, it is necessary to fill a column in then Lookup or Parametric table with values having a 
pattern of some type.  For example, you may wish to enter 1, 2, 3, 4, and 5 in the first 5 rows of the column 
and then repeat these values in the next five rows and so on down the table.  Alternatively, you may wish to 
enter 1, 1, 1, 1, 1 in the first 5 rows followed by 2, 2, 2, 2, 2 in the next five rows and so on.  The capability to 
enter these pattern types is now  provided in the dialog that appears when you click on the triangular icon in 
the upper right corner of the column header cell.   
 
$Bookmark Version 6.200 
Version 6.200  4/12/01 
Examples are now accessible from the Examples Menu.  You can remove this menu by moving the 
Examples folder out of the USERLIB folder. 
 
Version 6.194  4/04/01 
A plot can be duplicated by right-clicking on the tab at the top of the window.  A dialog window appears with 
a duplicate button.  The duplicate plot provides an easy way to create a plot template so that all of your plots 
have the same appearance. 
 
Version 6.186  3/26/01 
Integral tables can now be created in the LaTeX/PDF report. 
 
Version 6.185  3/24/01 
If a single file contains multiple EES library or external routines, that file will appear as an expandable folder 
in the Function Info dialog window, making it easier to locate the routine and access its information.  For 
example, the 90 functions and procedures appearing in the SETP.LIB file (supporting the Solar Energy 
Thermal Processes textbook by J.A. Duffie and W.A. Beckman) appears as a single folder item in the list 
until it is expanded.   
 
Version 6.184  3/22/01 
Help for external functions and procedures loaded at startup or manually with the Load Library command is 
now provided in the Help menu. 
  
Version 6.181  3/20/01 
Thermophysical properties (density, specific heat, thermal conductivity, viscosity, and volumetric coefficient 
of expansion) as a function of temperature for many substances are now provided in the 
ThermoPhysical_Prop.lib library file.  For example, the density and specific heat of copper at 300 K can be 
obtained using: 
rho=rho_('Copper,300) 
c=c_('Copper,300) 
 
Version 6.181  3/16/01 



Improved thermodynamic and transport property information has been implemented for R123. 
 
Version 6.179  3/13/01 
A limitation on the auto-update plotting option has been that the number of data points that are plotted had to 
be constant.  This limitation is removed with an option (accessed by pressing the DATA button in the Modify 
Plot dialog) that will plot all rows of data in the selected table.   
 
Version 6.177  3/10/01 
Property data for ideal gas n-Hexane (C6H14) and n-Octane (C8H18) have been added. 
 
Version 6.172 3/05/02 
Ideal gas property data for acetylene (C2H2) have been added.  Transport property information for NO and 
NO2 are now available. 
 
Version 6.168  02/28/01 
The critical property routines, T_crit, P_crit, and v_Crit, are now implemented for ideal gas substances. 
 
Version 6.166  02/25/01 
Multiple plots can be selected in the Modify Plot command by holding the Shift key down while clicking (or 
dragging) the mouse in the plot line list.   If a change is made to a parameter, that change will be applied to 
all selected plots when the Apply or OK button is clicked.  This capability makes it easy to, for example, 
change the size of the symbols for all plots at one time.  
 
Version 6.165  02/24/01 
The output stepsize in the $IntegralTable directive will accept a variable name in addition to a numerical 
constant. 
 
Version 6.163  02/22/01 
If the stepsize in the equation-based integral function is identically 0, automatic step size adjustment will be 
used in the integration, just as if a stepsize were not provided. 
 
Version 6.160  02/18/01 
The crosshair cursor on the Plot Windows is now accessed by pressing both the Shift and Ctrl keys.  Just 
pressing the Ctrl key, as the crosshair cursor was formerly implmented, interfered with copy and paste 
operations on the Plot Window.    
 
Version 6.157  02/15/01 
High accuracy property data for n-hexane have been added to the data base. 
 
Version 6.151  02/03/01 
Property data for CarbonMonoxide have been implemented. 
 
It is now possible to copy objects from other applications (e.g., MathType, PowerPoint, etc.) and paste the 
object into an EES plot window.  The object can then be moved or resized in the usual manner. 
 
Version 6.142  01/20/01 
DATE$ and TIME$ string functions have been added to return the current date and time, respectively. 
 
Version 6.135  01/15/01 
A command to generate a high quality report in LaTeX and PDF (portable document interface) has been 
implemented in the  file menu.  To create and view PDF files, it is necessary to install a LaTeX compiler and 
Adobe Acrobat.  Both of these applications are available at no cost.  Instructions for downloading these 
applications and using the Create LaTeX/PDF Report command are provided in the online help. 
 
Property data for ideal gas C2H4 (ethylene) have been implemented. 
 
Version 6.130  01/08/01 
Thermodynamic functions CP and CV have been added to calculate the specific heats at constant pressure 
and volume, respectively.  CP provides exactly the same result as the SPECHEAT function.  The 



ISENTROPICINDEX function which in previous versions provided the ratio CP/CV has been replaced with 
the related SOUNDSPEED function which returns the speed of sound through the fluid in [m/s] or [ft/s]. 
 
Subprograms are now supported.  Subprograms are very similar to Modules, the difference being in how the 
calculations are actually done, as explained in the online help. 
 
Version 6.125 12/25/00 
Grouping of drawing object and text that it not used for input/output is now supported in the Diagram 
windows.  Use the group/ungroup buttons on the tool bar or right-click on a selection to access the grouping 
capabilites. 
 
Version 6.115  12/14/00 
High accuracy property data for Hydrogen have been added. 
 
Version 6.110  12 0 
The drawing environment on the Diagram and child Diagram windows have been improved.  It is now 
possible to copy graphic objects from and to external programs, such as PowerPoint and CorelDraw.  
Multiple graphic objects may be placed on the Diagram window, moved, and resized. 
 
Version 6.105  12/02/00 
The Copy Plot command has the capability of placing two copies of the plot on the clipboard.  One copy is a 
Picture (enhanced metafile) and the other is a high precision bitmap.  The high precision bitmap provides a 
high quality plot image, but it consumes a great deal of memory - particularly so if the image is in color.  
Starting with Version 6.105, the option of placing a bitmap copy on the clipboard is, by default, disabled.  
Instead, the picture is copied as an enhanced metafile with a default resolution of 600 pixels per inch so it will 
print at high quality from the application it is pasted into.   The resolution of the clipboard copy, and options 
for copying in color and as a bitmap can be changed in the Plots Tab of the Preferences dialog.  
 
Version 6.088  11/07/00 
Buttons have been provided on the Diagram Window Text Input Dialog to facilitate entry of subscripts, 
superscripts and symbols. 
 
Version 6.087  11/06/00 
If the Solution Window was visible when the file was saved, it will be visible when the file is opened. 
 
Version 6.076  10/22/00 
Multiple copies of EES will each have a unique name, e.g., EES(2), EES(3), etc.  An option is provided to 
eliminate the warning that appears when EES is started while other EES applications are running. 
 
Version 6.075  10/21/00 
High accuracy property data for n-pentane have been implemented.  n-Butane and R600 now both use the 
high accuracy property data for n-butane. 
 
Version 6.074  10/20/00 
A WARNING procedure has been implemented (similar to the ERROR procedure) to allow the user to 
display warning messages.  Previously, only the last warning message could be displayed.  However, now 
warning messages are placed in a message que and all of the messages are displayed when calculations 
are completed.  The warning messages are not generated or displayed unless the 'Show Warning Messages' 
checkbox in the Options tab of the Preferences dialog is checked. 
 
Version 6.066  10/10/00 
The Solution window provides separated tabbed windows to display values of local variables in functions, 
procedures, and modules.  This capability is controlled by the 'Show function/procedure/module values' 
control in the Options tab of the Preferences dialog. 
 
The $Import and $Export directives will accept Clipboard in place of a filename.   
 
Version 6.061  10/03/00 
Print Preview now offers Zoom In/Out capability. 
 



Version 6.056  9/24/00 
Comments can now be displayed in underline font.  The setting is provided for both screen and printed 
display in the Preferences dialog. 
 
Version 6.055  9/22/00 
It is now possible to send any macro command directly to EES from another application such as EXCEL.  
See the online help section for Dynamic Data Exchange (DDE) 
 
Version 6.044 9/4/00 
The StringLen returns the number of characters in the string constant or string variable supplied as an 
argument.  For example, StringLen(A$) returns the length of the string stored in variable A$. 
 
The NLookupRows function returns the number of rows in the Lookup table or Lookup file specified in the 
string argument.  For example NLookupRows('Lookup 1') returns the number of rows in the Lookup file 
named 'Lookup 1'. 
 
A help context  file can be provided with library help files.  The help context file has the same name as the 
library file but with a .CTX filename extension.  EES will look for the .CTX file when help is requested.  If a 
.CTX file is found, EES will open the file to find the context number for the topic that has the name of the 
function for which help is requested.  The Help file will be then opened directly to that topic.  See help on 
Library Files for details. 
 
Version 6.042 8/31/00 
The $SaveLookup directive will accept a ? or ?? for the filename that the data are to be saved to.  In this 
case, a standard save file dialog will appear from which the filename can be chosen.  For example: 
$SaveLookup TN$ ? 
will save the Lookuptable having a name that is stored in string variable TN$ to a file selected from the save 
file dialog and the selected file will replace the ? so that the save dialog does not reappear.  If ?? is used, the 
replacement will not occur. 
 
Version 6.041 8/30/00 
The $OpenLookup directive can have an optional second parameter which must be a string variable name.  
The name of the Lookup file that is opened is assigned to this variable.  For example: 
$OpenLookup ?? myLookupFile$ 
will bring up a standard file input dialog from which the file name can be selected.  That Lookup file will be 
opened and copied into the Lookup Table Window and myLookupFile$ will be set to the name of the file. 
 
Version 6.040  8/28/00 
Plots now over the option of a 2nd X axis (X2) scale.  The axis scale is initially placed at the top of the plot 
but it can be moved with the Ctrl up/down arrow keys.  The 2nd Y axis (Y2) scale can be moved with the Ctrl 
left/right arrow keys.  The Modify Plot dialog now provides additional controls to allow the axis scale to be 
changed after a plot is constructed.   
 
Version 6.035  8/18/00 
Thermodynamic property data for methanol have been implemented. 
 
Version 6.032  8/13/00 
Controls are now provided in the Modify Plot dialog to separately display error bars in the X and Y directions. 
 
Version 6.030  8/09/00 
Property data for R507A are now built into EES.  The transport properties for R404A, R407C, R410A, and 
R507A have been update using recent correlations presented by Geller et al.  See the online help for the 
respective fluids for details. 
 
Version 6.029  08/07/00 
The width and height of buttons in the Diagram window can be adjusted in Development mode by selecting 
the button and holding the Ctrl key depressed while pressing any of the arrow keys.  For example, Ctrl-right 
arrow increases the width of the selected button by 1 pixed.  Ctrl-Left arrow decreases the width.  If the Ctrl 
key is not pressed, the button position, rather than its size, will be changed. 
 



Version 6.022  07/27/00 
A menu item has been added in the Help menu to access the EES manual in Acrobat format.  The menu 
item will be disabled if file EES_Manual.PDF is not in the directory that EES is started from or if Acrobat is 
not installed. 
 
A $Import directive has been implemented to directly read variable values from a text file.  The $Import 
directive has the following format:   
 
$Import 'FileName.csv' A, B, C, X[1..5], G$ 
 
Note that both string and numerical values can be read from the disk file.   See the online help for details. 
 
A  ? or ?? can be supplied as the filename in the $OpenLookup directive (Professional version).  When the 
$OpenLookup directive is processed,, a Windows open file dialog will appear from which the filename can be 
chosen.  If a single ? is supplied, it will be replaced with the selected filename.  The double ? will not be 
replaced so that the open file dialog will appear everytime the $OpenLookup directive is processed. 
 
Version 6.020  07/20/00 
An expiration date can now be optionally specified for Distributable programs generated with the Make 
Distributable command (Professional version). 
 
Version 6.008  07/12/00 
The $OpenLookup directive will accept either a string constant or string variable for the Lookup file that is to 
be opened. 
 
Version 6.007  07/11/00 
The $SaveLookup directive will now accept string variables for both the Lookup tablename and the filename, 
e.g., $SaveLookup TableName$ FileName$ where TableName$ and FileName$ are set somewhere during 
the solving of the EES equations.  
 
Version 6.005  07/10/00 
It is now possible to place EES variable information (name, current value, and units) in a text item that 
appears in a Plot Window.  Clicking the text button the Plot Window toolbar will initiate a dialog in which a 
normal text item or EES variable information can be displayed. 
 
Version 6.001  07/04/00 
Right-clicking on a tab in the Parametric, Lookup, or Plot windows initiates a dialog in which the tab name 
and position can be changed.  A delete button is also provided to delete the window. 
Macro commands now recognize Paste Parametric and Paste Lookup commands. 
 
>Version 6.000  07/01/00 
Version 6.0 incorporates the following major improvements in the EES user interface. 
1.  There is no limit on the number of Parametric and Lookup tables.  Earlier versions allowed only 1 table of 
each type.   
2.  There is no limit on the number of Plot windows. (Earlier versions allowed 10.)   
3.  Tabs are provided on the Parametric, Lookup, and Plot windows for easy access.  The tab names can be 
changed by right-clicking on the tab. 
4.  Capability to insert and delete rows and columns in any table is now provided by right-clicking on the 
column header 
5.  The width of one or more columns in a table can be changed by selecting the column(s) by clicking in the 
header cell (top row) followed by right-clicking.  A pop-up menu will appear with Properties as one of the 
options. 
6.  A range of variable names can be selected when creating a new Parametric table or when adding 
variables to the table by pressing the Shift key. 
7.  Additional buttons have been added to the speed bar for access to the Lookup, Arrays, Integral, and Plot 
Windows. 
8.  The .WMF files previously used to store pictures in the Professional version are no longer needed. 
 
>Version 5.216  05/24/00 
Undo has been implemented for the Plot Windows. 



 
>Version 5.208  05/14/00 
The Property Plot now provides an option to present a psychrometric chart in the Mollier format which is 
commonly employed in European countries. 
 
>Version 5.201  04/30/00 
Selected rows or columns in the Parametric and Lookup tables can be deleted by pressing the Delete key or 
by applying the Delete command in the Edit menu.  The Undo command in the Edit menu now functions for 
operations on the Parametric and Lookup tables. 
 
>Version 5.199  04/29/00 
Property data for RC318 (octafluorocyclobutane) have been implemented.  Viscosity data are now available 
for iso 
ing theVersion 5.195  04/24/00 
The Tab key can now be used to move from one input to the next on the Digram Window.  The tab order can 
be set by right-clicking on the text while in the development mode (toolbar visible). 
 
>Version 5.191 04/15/00 
Thick dotted and dashed lines on plots is now an option.  Plots having dotted lines will now display properly 
when copied as a bitmap to another application, such as Word. 
 
>Version 5.186 04/09/00 
An autosave option has been added to automatically save your work to a temporary EES file.  The temporary 
EES file has the same name as the file that you are working on but the filename is prepended with a tilde (~).  
By default, EES will automatically save the temporary file every 10 minutes.  You will be prompted to enter a 
filename for a new file if you have not saved it at least once before the autosave attempt.  EES will 
automatically delete the autosave temporary file when a new file is created or opened or when EES is 
closed.  However, if EES quits unexpectedly, the last autosave file should be available to recover your work.  
The autosave options are controlled by settings in the Options tab of the Preferences dialog (Options menu).   
 
>Version 5.182 04/05/00 
Automatic rescaling of plot axes is now an option that is controlled for each axis with the 'Automatic scaling' 
checkbox in the Modify Axis dialog window.  When this option is selected, EES will automatically select 
appropriate axis scaling to accomodate the data in all plots for the plot window. 
 
>Version 5.180  04/01/00 
High accuracy property data are now available for isopentane, ethylene, and propylene. 
 
>Version 5.178  03/29/00 
Function VOLEXPCOEF returns the volumetric coefficient of thermal expansion for the specified fluid and 
conditions. 
 
>Version 5.175  03/26/00 
When an assignment of the form  Q=20*convert(Btu/hr,kW)   is used, EES will assign units of kW to Q.  EES 
will also propagate units on simple assignment statements, so that if a statement of the form T2=T1 is solved 
and T1 has units, T2 will be assigned to the same units. 
 
>Version 5.170  03/19/00 
When a variable is set using one of the built-in property functions, its units are now automatically assigned. 
 
>Version 5.157  02/25/00 
High accuracy property data are now available for R-23. 
 
>Version 5.151  02/09/00 
Background colors can now be assigned to text placed on the Diagram window. 
 
>Version 5.148  02/03/00 
The caption for each of the 10 plot windows can now be changed in the Modify Plot dialog window.   
 
>Version 5.146  01/30/00 



The automatic step size adjustment algorithm used in equation-based Integrals has been improved.  The 
parameters which control the calculation effort and accuracy of integration are entered in the Tolerances 
dialog (Options menu) which replaces the former Stop Criteria dialog. 
  
>Version 5.140  01/18/00 
An $EXPORT directive has been provided to allow selected variables to be written to an ASCII file in .TXT or 
.CSV formats.  This directive simplifies the task of copying results to an EES Lookup file or to another 
application. 
 
> Version 5.139 01/17/00 
EES now can read and write data with the .CSV file format.  The format provides a convenient method to 
export data from a Lookup table to another application. 
 
> Version 5.136  01/12/00 
Transport properties are now provided for lithium bromide-water mixtures with functions VISC_LIBR and 
COND_LIBR.  Details are available by clicking the Function Info button in the Function Info dialog window 
after selecting External routines and selecting one of these functions. 
 
> Version 5.133  01/09/00 
High accuracy property data for Argon is now provided. 
  
> Version 5.130  01/07/00 
EES is now Windows 2000 compatible. 
 
> Version 5.125  12/25/99 
Properties for refrigerant R152a have been added to the data base. 
 
The correlation for liquid transport properties presented by M.J. Assael et al., "Viscosity and Thermal 
Conductivity of Halogenated Methane and Ethane Refrigerants", IJR 22, pp. 525-535, 1999, has been 
implemented for R152a, R134a_ha, R22_ha, and R32. 
 
> Version 5.122 12/18/99 
Right clicking in the Row column of any table now brings up a menu that allows a back color or 
border to be associated with the row. 
 
> Version 5.115 12/05/99 
Simple algebraic expression involving previously set constants and parentheses can now be used to specify 
limits for the SUM, PRODUCT functions and the DUPLICATE statement. 
 
>Version 5.113  12/03/99 
High accuracy properties are now available for R22 in fluid R22_ha. 
  
> Version 5.110  11/28/99 
It is now possible to save a diagram input (.VAR) file with a specified file name using the Save button on the 
Diagram window.  The toolbar allows a Load button to be placed on the main Diagram window.  Clicking the 
Load button will open a specifed .VAR file and update all of the inputs fields in the Diagram windows.  
 
A Print button can be placed on Diagram windows with the Show/Hide Print button on the toolbar.  Clicking 
the Print button will print the contents of the window to the default printer. 
  
> Version 5.109  11/26/99 
The 255 character limit for the maximum length of the lines EES processes has been removed for 
comments.  It is now possible to enter long paragraphs of comments.  The comments will automatically line 
break to fill the Equations window if the Wrap Long Lines option in the Preferences Equations tab is selected.  
The Formatted Equations window will also line break the comments in the display window and in the printed 
output. 
 
> Version 5.106  11/22/99 
String variables can now be used to specify the units of other variables.  For example: 
 



  U$='kJ/kg' 
 h=15 "[U$]" 
 
The comment to the right of the 15 sets the units of variable h to U$.  The units could also be set  in the 
Variable Info dialog or by clicking on h in the Solution window.  In any case, EES will recognize that U$ is a 
string variable and set the units of h to the string that is assigned to U$. 
 
> Version 5.101  11/14/99 
Commands to control Microsoft WORD have been added to the Macro command list.  It is now possible to 
open a WORD document, paste the solution window, tables, and plots, save the WORD document and close 
WORD, all with Macro commands in EES. 
 
> Version 5.094  11/04/99 
 It is possible to use a drop-down list in a Diagram Window to set the values of one or more EES variables.  
This is accomplished by following the string that is to be displayed with characters // and then with one or 
more EES equations on one line.  For example, the string 
  
    Copper // density=8933; conductivity=400 
 
will display Copper in the drop-down list, but EES will execute the statements to the right of the // characters 
when the a choice is made from the drop-down list or when calculations are initiated.  If the string is 
 
   User Input // density=?; conductivity=? 
 
EES will look for Diagram Window Output specifications for Density and Conducitivity, and if found, they will 
be changed to Input variables.  This capablity provides a method of exchanging Input and Output variables 
on the Diagram window.  See the on-line help for the Diagram Window for more information.  Also, look at 
new example Diagram_IN_OUT. 
 
> Version 5.090  10/31/99 
A new property function called SURFACETENSION provides surface tension data for real fluids. 
  
> Version 5.088  10/28/99 
High accuracy thermodynamic properties of water are now provided in substance Steam_IAPWS which 
implements the  1995 Formulation for the Thermodynamic Properties of  Ordinary Water Substance for 
General and Scientific Use, issued by The International Association for the Properties of Water and Steam 
(IAPWS).  This capability is available only in the Professional version. 
 
> Version 5.083  10/18/99 
The Lookup$Row function has been implemented.  See the online help for details. 
  
> Version 5.079  10/14/99 
Appending _hat to a variable name, e.g., F_hat, places a ^ symbol above the name. 
 
RANDOM(A,B) returns a uniformly distributed number in the range between A and B.  This function can be 
used only within EES Functions and Procedures.  
 
> Version 5.067  10/3/99 
The contour plot algorithms now allow the plot resolution to be specified.  The calculation speed has been 
increased by an order of magnitude 
       
> Version 5.061 9/28/99 
Clicking the left mouse button in the leftmost column of a row in any table will select all of the cells in that 
row.  If the mouse button is held down while the mouse is moved to other rows, these rows will be added to 
the selection.  Rows can also added by holding the Shift key down while clicking in the leftmost column.  All 
of the cells in a column can be selected in a similar manner by clicking the left mouse button in the column 
header.  Note that it is now necessary to right-click in the cell header to bring up the dialog that allows the 
format, units, and other information in a column to be edited.  Right-clicking after selecting a range of cells 
brings up a popup menu that allows selected printing, copying, and other options. 
     



> Version 5.059 9/26/99 
A plot window that is displayed using a plot window button on a Diagram window now has a small button at 
the bottom right which returns the focus to the Diagram window that contains  the plot window button. 
 
The IsentropicIndex function has been added to the list of built-in property functions.  
  
> Version 5.058 9/24/99 
The IsIdealGas property function has been added.  The use of this function is explained in the online help. 
 
> Version 5.055 9/21/99 
The bitmap resolution and black&white/color setting of plots copied to the clipboard can now be set in the 
Preferences dialog/Plot tab.  Use the Paste Special command in an external application such as a word 
processor, to select the type of paste operation.  Pasting a plot as a Device Independent Bitmap provides the 
highest quality image but it requires the most  memory.  Pasting as a picture requires the least memory. 
  
> Version 5.053 9/18/99 
Calculate buttons can now be placed on child Diagram windows.  Link and Plot window buttons  can display 
a bitmap. 
 
> Version 5.048 9/12/99 
EES will replace _star with a superscript * in the Solution and Formatted Equations windows.  For example, 
T_star will display as T*. 
 
> Version 5.047 9/9/99 
The Units.Txt file has been modified to accept µm as a length unit.  To enter µm, hold the Alt-Key down and 
type 230 on the  numeric keypad.  Let the Alt key up and the µ should appear.  Then enter m.  Other useful 
characters are Alt-248 which displays the degree symbol ° and Alt-250 which appears as a dot (·) and is 
used to represent multiplication.  The Convert routine in EES will accept a hypen (-), a  star (*) or character 
250 (·) as a separator for units.  For example, W-hr, W*hr and W·hr will all be accepted in the Convert 
command for Watt-hours. 
 
> Version 5.044 9/5/99 
You may not have known that there was a 64 kByte limit to the amount of text that could be entered into the 
Equations window.  That limit has been raised to 128 kBytes. 
 
> Version 5.042  9/3/99 
A larger range of colors for objects (boxes, circles, and lines) on the Plot and Diagram windows is now 
available. 
 
> Version 5.040  8/31/99 (Professional version) 
The Make Distributable dialog window now has buttons to save and load scripting information.   The save 
button copies all information in the Make Distributable dialog window to a file having a .MDI filename 
extension.  The load button allows a .MDI file to be opened so that the information in the file can be used to 
fill the fields in the Make Distributable dialog window.  
 
> Version 5.038  8/28/99 
The transport property correlations of Vesovic et al. have been implemented for fluid CarbonDioxide_ha. 
 
> Version 5.034  8/24/99 
EES will now accept HTML files (*.htm) help files in addition to ASCII text (*.txt) and Windows help (*.hlp) 
files.  Any of the three file types can be used to provide user help for library files, EES  files loaded from the 
Textbook menu, and files created with the Make Distributable command.  Help buttons placed on the 
diagram window and child diagram windows can also now use any of the three help file formats. 
 
> Version 5.032  8/22/99 
Child diagram windows can now have their own child windows (Professional version). 
     
> Version 5.028  8/17/99 



Right-clicking on Parameteric, Lookup, Arrays, or Integral table will bring up a pop-up menu allowing the 
currrent selection to be cut, copied, or printed.  This option provides a convenient  way to print a specified 
section of a table.  
 
> Version 5.026  8/15/99 
 Holding the Shift key down while creating or resizing lines/arrows on the Plot and Diagram windows will 
constrain the lines to be horizontal, vertical, or on a 45 degree angle.  If the Shift key is depressed while 
creating or resizing rectangles or circles, the rectangle or circle will be drawn with equal height and width. 
 
The PRANDTL function has been added. 
 
Right-clicking the mouse on the Equations window now brings up a pop-up menu allowing the current 
selection to by commented, cut or copied. Access to the Variable Info dialog window is also provided. 
 
>Version 5.020  7/31/99 
Temperature - enthalpy plots can be generated using the Property Plot option in the Plot menu for 
substances using the high accuracy Fundamental Equation of State.  The on-line help for Fluid Property 
Information identifies the substances that use this equation of state. 
 
> Version 5.016  7/27/99 
A temperature conversion function has been implemented.  The ConvertTemp function has the following 
format:  ConvertTemp('C', 'F', T).  The first two parameters are string constants or string variables which 
must be C, K, F, or R, respresenting the Celsius, Kelvin, Fahrenheit, or Rankine scales.  The third parameter 
is a temperature in the scale indicated by the first parameter.  The function returns the temperature in the 
scale indicated by the second parameter.  In the example above the function would return the temperature in 
F corresponding to the temperature T in C.  The single quotes around the string constants are not required. 
      
> Version 5.015  7/26/99 
An IntegralValue function has been implemented to allow retrieval of data from the Integral Table. (See 
version 5.004) 
 
> Version 5.014  7/22/99  
The arrowhead size can now be changed on the Plot and Diagram windows.  The arrowhead  size is 
automatically scaled when the Plot or Diagram size is changed. 
 
Ø Version 5.012  7/19/99 
Ø A Data button has been added to the Modify Plot dialog.  This button becomes active if the Automatic 
Update option is enabled.  When clicked, the Data button allows the source of the plotted data to be 
changed.  It is possible to change the range of rows, the X and/or Y- axis columns and the table from which 
data are plotted.  EES will automatically update the  plot to reflect the change in the data source.  The most 
common use for this capability is to  change the range of rows that has been previously selected for a plot 
line. 
Ø  
 High accuracy properties for Helium have been incorporated. 
 
> Version 5.005  7/12/99  
Link buttons can now be placed on the Diagram window in the Professional version.  Clicking a link button 
can be used to start an external application or run a specified EES program.  This capability simplifies 
chaining EES programs for sequential operation.  High accuracy property data for nitrogen have added 
replacing the previous less- accurate correlations.  The new property data are valid from 65 to 2000 K at 
pressures up to 1000 MPa.  
 
> Version 5.004  7/03/99  
A new directive called $IntegralTable allows intermediate values of specified variables  during numerical 
integration with equation-based Integral functions to be automatically  placed in an Integral Table.  The 
values in the Integral Table can be plotted, printed, or copied.  See the on-line help for details. 
 
> Version 4.993  6/12/99  
High accuracy thermodynamic and transport properties for propane and isobutane have been added. 
 



The Professional version provides a means of creating a distributable program that can   include up to five 
EES programs.  Normally, the first EES program is the one that shows up   when the distributable program is 
launched.  However, placing a /# (where # is an integer   between 1 and 5) as a parameter will select that file 
at startup.  For example, entering   MyDist.exe /2 into the Windows Run dialog window will start the 
distributable program called  MyDist.exe and bring up the second file. 
 
Text and objects on the Diagram windows can now be selected using a selection rectangle, as  in most 
drawing programs.   
  
> Version 4.989  6/9/99  
 A help button can be placed on the Diagram window and on Child Diagram windows.  Clicking  the Help 
button opens a specified help ASCII text or Windows .HLP file.  The Windows menu Diagram window item 
will now list child Diagram windows (Professional version).  
  
> Version 4.987  6/7/99  
The Viscosity and Conductivity functions now allow any set of independent properties as inputs. The Convert 
function will now accept a star (*) as well as a dash (-) as a separator between  units. 
 
> Version 4.985  5/28/99  
A function called NTABLEROWS has been added.  This function takes one string argument  and that 
argument may be 'Parametric', 'Lookup', or 'Arrays' or the name of a Lookup file stored  on disk.  In this case, 
the name may be provided as a string constant or a string variable.   The  function returns the number of 
rows in the specified table.  
 
> Version 4.980  5/20/99  
Two new directives have been added to the Professional version.   $OPENLOOKUP  LookupfileName  will 
open the a Lookup Table and read the data in the file designated as   LookupFileName.   SAVELOOKUP 
LookupfileName will save the Lookup Table in a file with   the specified name. 
 
A SAVE button can now be placed on the Diagram window of Distributable programs  (Professional version).  
When clicked, the SAVE button saves the current values of all variables  and the current  values for all input 
variables in the Diagram window in a .VAR file having the  same name as the parent EES file.  This file is 
automatically loaded with the distributable  program is opened which restores the inputs in the Diagram 
window to the values they had  when the SAVE button was clicked. 
 
> Version 4.970  5/1/99 - 612/99  
High accuracy property data are now available for a number of fluids including carbon dixiode,  methane, 
ethane, propane, isobutane, n-butane, R32 ammonia, oxygen  and R134a.  The on- line help has been 
modified to provide the source of the data and its limits of  applicability.  The Property Plot dialog (Options 
menu) has been expanded to allow additional information to be placed on the property plots. 
 
> Version 4.960  4/14/99  
Palettes for lower and upper Greek letters and special symbols have been added to the  Format Text dialog 
to simplify input of text that is to be placed on a Plot window.  The Format Text dialog appears by right-
clicking or doubling clicking on a text item in the Plot window. 
 
> Version 4.949  3/26/99  
(Professional version) If the cursor is positioned over an input or output variable in the Diagram window or 
child Diagram window, the name of that variable will be displayed as a hint if the tool bar is  visible.  
 
> Version 4.946  3/24/99  
To maintain consistency with other Windows software, it is now necessary to hold the Shift key  down when 
selecting multiple items in the Plot and Diagram Windows.  Up to this version, pressing the Shift key 
displayed crosshairs on the Plot windows.  Now this capability is enabled  with the Ctrl key.  
 
> Version 4.943  3/22/99  
The Print command dialog has been modified to allow selected printing of child Diagram windows 
(Professional version). 
  
> Version 4.942  3/19/99  



The Find command can now be used in the Residuals window. 
  
> Version 4.935 03/11/99  
The Professional version now allows up to 10,000 variables and equations.  
  
> Version 4.917 02/15/99  
The Residuals window now uses bold font to show which variables are determined by the  equation(s) in 
each block.  This capability makes it easier to see the order in which EES is  determining the values of the 
unknown variables. 
  
> Version 4.911 02/08/99 and 4/07/99  
The units of a variable which is on the left side of an equation (by itself) in the Equations window  can  now 
be automatically set using a comment in which the units are enclosed in braces.  Additional text following the 
unit specification can be provided.  For example:  
      h=400 "[Btu]"     
      P4=P3/100 "[bar]   this equation will set the units of variable P4 to bar"   
 
> Version 4.908 02/03/99  
A Check Units command has been added to the Calculate menu.  This command will check the  dimensional 
and unit conversion consistency of all equations except those in functions and  procedures.  It is necessary 
to enter the units of each variable for the checking process to  function properly.  The units can be entered in 
the Variable Info dialog window or in the Solution  window.  The checking algorithm cannot know the units of 
conversion constants, so it is best to  avoid them in your equations.  The Convert function should be used 
instead.  For example,  suppose you have two variables, L_inch and L_feet, whose units are set to inches 
and feet,  respectively.  This following equation will not check properly because the units of 12 are not  
known. 
         L_inch=L_feet*12   
However, if the convert function is employed as shown next, the equation will be accepted.  
        L_inch=L_feet*convert(ft,in) 
 
> Version 4.906 01/31/99  
A set of string functions has been implemented to facilitate manipulations of string variables.  The string 
variables are: CONCAT$, COPY$, LOWERCASE$, STRING$, STRINGPOS, STRINGVAL, and 
UPPERCASE$.  Detailed information is available in the on-line help. 
 
> Version 4.896  01/11/99  
The size of the symbol used in plots can now be modified in the Modify Plot dialog.  The symbol  size scales 
proportionally as the plot rectangle is resized.   In plots with many points, placing a  symbol at each point 
results in a messy plot, although some symbols may be needed for  plot line identification.  The Modify Plot 
dialog now also provides a control to specify symbols  to be drawn every N points, where 1<N<# of points.  
The Modify Plot dialog is accessed with the plot menu or by right-clicking on the plot window. 
  
> Version 4.890   01/04/99  
A plot window access button has been added to the Diagram window toolbar.  When clicked, the plot window 
access button displays a small dialog in which the desired plot window and button caption can be entered.  A 
button with this caption then appears on the Diagram window and it can be dragged to the desired location if 
the tool bar is visible.  Clicking this button when the tool bar is hidden will display the Plot window. 
  
> Version 4.884  12/15/98  
The operation of the Diagram window has been changed.  First, a tool bar has been added to this window 
and to the child Diagram windows (Professional version) to create graphic objects (text, lines/arrows, 
rectangles, and ellipses) and to manipulate these objects.  Second, the Diagram window now has two 
modes: development and application mode.  The development mode is active when the tool bar is visible.  
Objects in the Diagram window can be moved, modified, or deleted in development mode.  The entire 
window can be resized.   However, the input variable edit boxes and drop-down lists are disabled in 
development mode.  When the tool bar is hidden, the Diagram window is in  application mode.  In application 
mode, the graphic objects cannot be moved or modified. The Diagram window will  accept user input 
and, after calculations are completed, the values of output variables will be displayed.  Ctrl-D is a keyboard 
shortcut for the Diagram window.  If the Diagram window is not in front, Ctrl-D brings it to the front.  If the 



Diagram window is foremost, Ctrl-D toggles the visibility of the tool bar.  Shift-Ctrl-D toggles the visibility of 
the tool bar in the Diagram window and all child diagram windows. 
 
> Version 4.882  12/10/98  
A tool bar has been added to the plot windows to facilitate adding text, lines/arrows, boxes and ellipses.  A 
Show/Hide tool bar command in the Plot menu replaces the Add Text and Add Line commands.  Multiple 
items on the plot window can now be copied, moved, and alligned. 
  
> Version 4.876  11/30/98  
Plots printed by EES on a laser printer look great.  However, when the plot is copied and pasted to another 
application, such as a word processor, the quality of the printed plot is not as good.  The reason for this 
degradation in quality is that the plot is copied at the resolution of the screen.  However, in this version, the 
Copy Plot command now also puts a high resolution bitmap on the clipboard.  You can select a picture (as 
before) or a bitmap using the Paste Special command in the external program. The bitmap requires much 
more memory, but it produces a high quality image when printed. 
 
> Version 4.874 11/27/98  
Selected text items in the Diagram window can now be cut, copied, and/or pasted to a child diagram window 
or to a Diagram window in a different EES program (Professional version only).  To select one or more text 
items in the Diagram window, hold the Shift key down while clicking on the text item. To select a drop-down 
string list, click just the left of the rectangle.  Selected text items are displayed within a red dotted rectangle.  
To unselect text items, click anywhere on the Diagram window, but not  on a text item.  
 
>  Version 4.873  11/25/98  
The Plot Windows 'fly-out' menu that appears when the Plot Windows menu item is selected from the 
Windows menu now displays each plot window as the mouse is moved over the different plot window menu 
items.  This behavior should make it easier to find the plot window that you wish to move to the front.  You 
can disable this behavior by holding the Ctrl key down while selecting the plot window menu item. 
 
> Version 4.871  11/23/98  
Variable Information files with filename extension *.VAR can now be opened with the $INCLUDE directive. 
 
> Version 4.867  11/16/98  
Two small buttons have been added to the Variable Info dialog (Professional Version only) to allow  variable 
information to be read from or saved to a file.  The variable information file has a .VAR filename  extension, 
but it is a text file that can be opened in a word processor or spreadsheet.  Variable   information data can be 
saved to an existing .VAR file.  In this case, the file is updated with the current  information for the variables 
that are in use.  Information in the file concerning variables that are not   currently in use is not modified or 
deleted.  If a program contains one or more modules, a dropdown  list appears at the top center of the 
Variable Info dialog from which the module or main program can be  selected.  Variable information are read 
or saved for the selected module or main program.  The read   and save variable information buttons make it 
very easy to prepare and use a file containing your   common variables with appropriate guess values, limits, 
and units.   
 
> Version 4.863  11/11/98  
The Lookup table will now accept string data, as well as numerical data.  The format style must be set  to 
String.  This change is made by clicking in the column header and selecting String as the style.  The  
LOOKUP$ function is used to return string data.  It operates exactly like the LOOKUP function.  
 
> Version 4.859  11/05/98   
A Directories Tab has been added to the Preferences dialog in the Options menu.  Default directories for 
opening and saving files can now be specified.  In addition, a directory in addition to the USERLIB directory 
can now be used to preload library files when EES is started.  See the on-line help for details. 
  
> Version 4.853  10/27/98  
An EES variable with name JTHETA will be displayed as a J in Symbol font, which appears as a  'curly 
theta'.   
 
> Version 4.852  10/26/98  



The maximum number of rows in the Parametric and Lookup tables has been increased to 9000 from the 
former limit of 6500.  There is no limit to the number of rows in the Professional version. 
 
> Version 4.851  10/25/98  
A green 'go' triangle is displayed in the upper left cell of the Parametric table.  Clicking the left mouse button 
in this triangular area will initiate the Parametric Table calculations for the rows indicated  below the triangle.  
The row range is that selected during the last use of the Solve Table dialog.  To select a different range, click 
the left mouse button in the first row.  Hold the Shift key down and then click the mouse in the last row.  
Continue to hold the Shift key down while clicking in the green triangle. 
 
 A shorthand notation for array variables has been implemented to facilitate passing of array variables to 
internal and external Functions and Procedures.  A range of array variables can be indicated by separating 
the first array index value from the last index value by two decimal points. For example, X[1..5] can be used 
in place of X[1], X[2], X[3], X[4], X[5].   This shorthand notation is supported for two dimensional array 
variables as well.  Since all EES statements must be 255  or fewer characters, this notation can be used to 
pass long argument lists.  The notation can be used in the arguments of function calls and CALL statements, 
in Function and Procedure  statements and in $Common directives.  See Array Range Notation in the online 
help for details. 
 
 The AVERAGE function has been added as a built-in function.  The SUM function has been modified to 
accept a list of argument, in addition to the former index-based format. 
 
 There is no longer any inherent limit on the number of variables that can be passed to an external procedure 
with .FDL format.  (The former limit was 50 inputs and 50 outputs).  Up to 1000 variables can be passed in 
the argument list of external functions using array range notation.  
 
> Version 4.850 10/22/98  
EES now will display unmatched left or right parentheses in bold during input in the Equations Window. 
  
> Version 4.847 10/17/98   
A Calculate button can be placed on the Diagram Window.  Right clicking on the Calculate   button allows 
both the button caption and the action taken when the button is clicked to be modified. 
 
> Version 4.821 9/04/98   
Support is now provided for mouse wheel scrolling.    
 
> Version 4.818 9/01/98  
The professional version of EES will now allow macro files to be played from another  application using 
dynamic data exchange control.  The online help provides the details. 
  
> Version 4.812 8/22/98  
EES now provides bar plots and contour plots in addition to the X-Y plots provided in previous versions.  The 
New Plot Window command displays a submenu with the three plot types.   Look at the online-help for X-Y 
plot, bar plot and contour plot for details. 
 
EES recognizes three externally compiled files of types .DLF, .DLP, and .FDL.  Previously, only one routine 
could reside in an externally compiled file.  It is now possible to include one or more external routines in a 
.DLL file.  All three file types can be included in the same file.   The mechanism for telling EES the names 
and types of the external routines is to provide  three short routines in the DLL file with names DLFNames, 
DLPNames, and FDLNames that do nothing but return the calling names of each routine type in the DLL file.  
DLFName, DLPNames,  and FDLNames must be exported in the DLL.  They have one argument which is a 
character  string.  The character string is filled with the names of the routines of each type that are contained  
in the DLL file.  A comma separates each file name.  A zero length string is used to indicate that  there are 
no files of that type.  An example, written in DELPHI 4 is provided in the on-line help. 
 
  
> Version 4.810 8/20/98  
Right-clicking on the Calculate button in the Diagram window will allow the Calculate button caption to be 
changed. 
 



A French version of EES has been developed.  Contact F-Chart Software if this is of interest to you.  
 
> Version 4.802  8/10/98  
The New Plot and Overlay Plot commands have been modified to allow multiple variables to be selected in 
the Y-axis list.  A separate plot line will be generated for each selected variable.  All selected variables will be 
plotted with the same axis scale.  If more than one Y-axis variable is selected, the symbol and color list 
boxes will display 'auto'.   With the 'auto' option, the  symbol and color for each plot line will be automatically 
selected by EES so that each plot line has a different symbol and color.  This feature can be overridden by 
simply selecting the symbol and color. 
 
> Version 4.791   7/25/98  
Subscripts and superscripts are now displayed in comments in the Formatted Equations  window. 
 
>Version 4.790  7/20/98  
The capabilities of the Debug window have been expanded.  If EES detects that a solution is constained, the 
DEBUG window will display all variables and equations that are are constrained.  Clicking on a variable will 
open the Variable Info dialog where the lower or  upper bound on the variable value can be changed. 
  
> Version 4.784  7/6/98 
The Variable Info dialog now provides a Show Array Elements checkbox control when one or more arrays 
are present in the Equations window.  When this control is selected, all array  elements appear in the 
Variable Info dialog and the guess value, bounds, display format, and units can be set for each individual 
element as before.   However, when the control is not  selected, all arrays elements are represented by a 
single entry.  For example, X[ ] represents all array elements with parent name X.  If any of the 
characteristics for the array are changed,  that change is applied to ALL array elements.  For example, 
changing the guess value for X[ ]  will result in the new guess value being applied to all array elements in 
array X.  However, other  characteristics, such as the bounds and units, would not be affected. In addition, 
the array name  can be changed by editing the name in the first column of the Variable Info dialog.  (Note 
that the  names of array elements, e.g., X[5], can not be edited.)  If an array name is changed, that  change 
is applied to all array elements.  The change occurs in the Equations window, the  tables, and the Diagram 
window.  
 
> Version 4.782  7/1/98 
A Calculate button can now be placed on the Diagram window to more conveniently initiate calculations 
involving input and output variables in the Diagram window.  The button is enabled with a check box control 
in the Add Diagram Text dialog which appears whenever Diagram window text is added or modified.    
 
> Version 4.781  6/26/98 
 Undo is now accessible for the Solution window.   
 
> Version 4.776  6/15/98 
Store and Retrieve Parametric Table commands have been added to the Tables menu.  The Store 
Parametric Table command will save all information relating to the existing Parametric table in a binary file 
having a .PAR filename extension.  The Retrieve Parametric table will read a specified .PAR file and restore 
the Parametric table to the same condition it was in when the Store Parametric Table command was issued.  
Although EES only allows one Parametric table at a time, the Store and Retrieve Parametric Table 
commands provide almost the same effect as having multiple Parametric Table windows. 
 
> Version 4.775  6/10/98 
This version heralds the introduction of the Professional version of EES.  The Professional  version provides 
the following capabilities:   
1.  A series of EES instructions (called a macro) can be recorded with the Build Macro command in the File 
menu.  EES can later be started from the Windows Run command or  from a different program to replay all of 
the instructions in the Macro file.  Used in this manner, EES can be directed to solve a set of equations in a 
specified text or EES file and put the solution into another specified text file without ever appearing on the 
screen.  The online help for the Build Macro command provides details. 
 
2.  The capabilities of the Diagram Window have been expanded.  It is now possible to define 'hot areas' in 
the Diagram Window which, when clicked, bring up a child Diagram window having all of the same 



capabilities as the main Diagram Window.  A link to 'hot areas' and 'child Diagram windows' can be found in 
the online help for the Diagram window. 
 
3.  The Make Distributable Program was available in previous versions.  However, this capability is now 
available only in the Professional version. 
} 
{! Contact F-Chart Software if you wish to update your existing version of EES to a Professional    version. 
} 
{ 
> Version 4.770  6/08/98  
Entering the values of array variables can be painful in EES.  For example, if you want to define array X with 
10 values ranging from 1 to 10, you would have to enter X[1]=1; X[2]=2; etc.  The new  Insert/Modify Array 
command in the Edit menu has been implemented to help enter values for  one and two-dimensional arrays.  
After selecting this command, you can enter (or paste) the  values directly into a spreadsheet-like table.  
When you click the OK command, EES will  generate the necessary EES equations to define the array at the 
bottom of your Equations  window.  EES will surround the array equations with a special set of comments.  If 
you later  modify the array, EES will look for these comments to determine if the array has already been  set.  
Set the on-line help for details.   
 
> Version 4.750  5/02/98  
Multiple text items can be selected in the Diagram Window by holding the Shift key down while clicking on 
the text item.  A red dotted box will be displayed around each selected text item.  Pressing the right mouse 
button (or selecting the Modify Diagram Text command  in the Options menu) will bring up a dialog window in 
which the characteristics (font, color, size, etc.)  of all selected text items can be changed at once.  Also, the 
dialog window allows the selected  text items to be aligned with respect to each other.  All selected text items 
move in response to  the arrow keys. 
 
> Version 4.750  5/02/98  
EES can now display superscipts in variable names in the Formatted Equations and Solution windows. The 
vertical bar character (|) signified the start of a superscript.  For example, G|o will display as G with a 
superscript o. 
   
} 
{!>Version 4.750  5/02/98    
Did you notice that this comment is a different color?  The exclamation character as the first  character of the 
comment causes this to happen.  You can now set the colors and styles of the  comments, and other 
information, in the Preferences dialog.  The Print in Color control has  been moved to the Print dialog where 
it is more visible and easier to access.} 
  
{> Version 4.741  4/13/98  
The printer can now be selected directly from the Print dialog. 
 
> Version 4.735  4/5/98  
The Screen tab of the Preferences dialog now allows comments in the Equations and Formatted Equations 
window to be displayed in italics or bold. 
  
> Version 4.733  4/1/98  
Refrigerant names  R717, R718, and R744 are now recognized. 
 
> Version 4.726  3/21/98  
A number of conveniences have been added to the Plot Windows. It is now possible to select  more than one 
text item or line.  Once selected, changes can be applied to all selected items at one time.  For example, the 
font size of all selected text items can be changed at once. 
 
Each press of an arrow keys moves all selected text items or lines one pixel in the arrow  direction. 
 
When more than one text item or line is selected, alignment buttons are provided to align the  selected items 
relative to each other. The alignment option becomes available after clicking the  right mouse button or 
double-clicking the left mouse button. 
 



The Delete key will delete all selected text items or lines.  The Paste command will restore the deleted items. 
 
Holding the Ctrl key while resizing a plot prevents the text size from changing proportionally with  the plot 
size.  Also in this version, the text within a plot will be moved to appropriate locations in the plot if the scale 
on the X or Y axis is changed. 
 
 
> Version 4.715  3/01/98 
   Two new built-in functions have been added.   
 Erfc(X) is the complement to the Error function equal to 1 - erf(X).   
 CIS(theta) is a short way of entering COS(Theta)+i*SIN(Theta).    
 
> Version 4.710 2/21/98 
The psychrometric chart produced by the Property Plot command now allows the user to enter  the lower and 
upper temperature limits for the abcissa. 
  
> Version 4.700  1/23/98 - 2/2/98 32-bit only)  
The keyword Subprogram has been changed to Module.  Modules no longer require a colon to distinguish 
inputs from outputs.  Commas are used to separate the arguments.  The entire Module concept has been 
revised.  When a Module is called, the equations in the Module are transparently grafted into the equations in 
the main EES program.  The result can be  seen in the Residuals window which lists all of the equations that 
are solved more in less in the order that EES solves them.  Additional information is provided in the online 
help.  
 
>  (Version 4.660  1/12/98 32-bit only)  
EES now can solve equations with complex variables.  Many changes have been made to support this 
capability.  For details, look at Complex Numbers in the online-help. 
 
>  (Version 4.649  12/25/97 32-bit only)  
The number of allowable plot windows has been increased from 5 to 10.   The plot windows are accessed 
with the Plot Windows submenu in the Windows menu.  The plot windows can also be accessed with 
keyboard shortcuts.  For example, Ctrl-1 will bring Plot Window 1 to the front.   The keyboard shortcuts for all 
menu commands are shown in the menus. 
 
 NOTE:  EES versions 4.648 and earlier can only read 5 plot windows.  If you save a file having  more than 5 
plot windows, a General Protection error will result when you attempt to open this file with an older version of 
EES.  EES should, however, then function normally although some of the plots will be lost.   
 
> (Version 4.643  12/05/97 32-bit only)  
By popular demand, a control has been added to the Print dialog to allow printing of multiple  copies (32-bit 
version only). 
 
> (Version 4.634  11/09/97)  
It is now possible to display gridlines on plots at positions between the axis numbers.  To change the 
appearance of an axis display, double-click the left mouse button (or click the right mouse button) on the 
axis.  The Modifiy Axis dialog will appear.  Select the Grid lines control, if it is not already checked.  The # 
Ticks/Division should appear within a rectangle. Clicking  the left mouse button within this rectangle will 
cause the display to change to # Grids/Division.  In this case, grid lines instead of tick marks will be 
displayed.  
 
> (Version 4.625  10/20/97 32-bit only)  
Great news for Europeans!  EES is now able to represent numerical values using a comma rather than a 
decimal point as the decimal separator.  To invoke this capability, you must set the Decimal Symbol in the 
Number tab of  the Windows Control Panel Regional  Setting dialog window to a comma.  Then start EES.  
EES will automatically convert the format of all values in previously saved files.  The comma is now the 
decimal separator.  The list  separator character, which in the U.S. version is a character, is now a 
semicolon.  The  semicolon in the U.S. version was used to allow multiple equations to be place on one line.  
Use  the period character for this purpose. 
 
> (Version 4.616  9/30/97)    



Uncertainty analysis has been implemented.  The Uncertainty analysis commands are  in the Calculate 
menu.  The Uncertainty Propagation Table places uncertainty values in the  Parametric table.  Subsequent 
plotting allows error bars to be drawn representing the   propagated error.  See the on-line help for details. 
 
> (Version 4.616  9/30/97)  
The column widths in the Parametric, Lookup, and Arrays tables may now be individually  changed.  To 
change the column width, move the cursor to the header row and position  it over a column divider line.  The 
cursor icon will change to a column size icon.  Drag the  column divider line to its new position. 
 
> (Version 4.614  9/21/97 32-bit only)  
Functions T_crit, P_crit, and v_crit have been added to return the critical temperature, pressure,  and specific 
volume respectively.  These functions take one parameter which is the name of the fluid.  A string variable 
can be provided. 
 
>  (Version 4.611  9/18/97)  
A menu speedbar has been implemented with one-button access to the most commonly applied menu 
commands.  If you wish, you can disable the menu speedbar with the  Preferences command in the Options 
menu by setting the 'Display menu speedbar' control. 
 
> (Version 4.610  9/17/97) 
 The Default Variable Information command in the Options menu allows the guess values,  bounds, display 
format and units for variables to be automatically set based on the the  first letter of the variable.   It is now 
possible to have multiple sets of Default Variable  Information by using the Load and Store buttons that have 
been added to the dialog.  Store will store the currently defined defaults in a file having a .dvi filename 
extension.  Load will load a previously-stored file and apply the defaults to all existing and new variables.  
The EES_DFLT.dvi file contains the variable defaults EES will apply when it is started. 
 
> (Version 4.600 9/01/97 32-bit only)  
Property data for R404A, R407C, and R410A  have been added.  These fluids are quite different  from any of 
the others in the data base in that they are blends.  R404A and R410A exhibit very little  temperature glide, 
so its T-s and P-h plots looks like those for a pure fluid.  However, the T-s and  P-h plots for R407C show the 
capabilities of the new property functions.   
 
> (Version 4.600 9/01/97 32-bit only) 
   Modules are now supported.  Modules are used exactly in the same manner as procedures.  The 
'Procedure' keyword is replaced with 'Module'.  The Module is accessed with a 'Call' statement.  The 
difference between a Module and Procedure is that the Module can use equality statements, rather than 
assignment statements as used in Procedures.  Each Module has its own set of variables.  Each Module can 
have up to 5000 variables.  The guess values for the Modules and main program are accessed with the 
Variable Info command.  See the on-line help for documentation. 
 
> (Version 4.459  8/09/97)  
EES will automatically load the HELLO.EES file if it finds this file in the EES main directory.   You can place 
messages, directions, or any information you wish in this file.   This file is  named HELLO.EES.  If you do not 
with this file to appear when you start EES, rename it or delete it.   Alternatively, hold the Shift key down to 
bypass opening the Hello.EES file. 
 
> (Version 4.458  8/07/97) 
Text items and lines/arrows on the plot windows can now be cut and copied to the Clipboard using the 
commands in the Edit menu.  This feature makes it easy to copy text and lines from one EES plot window to 
another. 
  
> (Version 4.457  8/04/97) 
Two new directives have been added:  
$Warnings On/Off controls the setting of the Warnings Option in the Preferences dialog  
$Arrays On/Off controls whether arrays variables are displayed in a separate Arrays table.   
Other directives are $Common, $Include, and $Complex On/Off. 
 
> (Version 4.456  8/02/97) 
The height and width of the Variable Info dialog can be changed. 



 
> (Version 4.454  7/30/97) 
The Lookup, Interpolate, and Differentiate functions will now accept an ASCII Lookup file, in addition to the 
binary .LKT file that wasaccepted in previous versions.  More information can be found in the online help 
under topic Lookup File Formats. 
 
> (Version 4.440  07/01/97) 
A bullet line type is now provided in the Add Line (Plot Menu) and Add Diagram Line (Options Menu) 
commands. 
 
A external procedure called JANAF is provided with EES.   JANAF provides the specific heat, specific 
enthalpy, and specific entropy (3rd law reference) as a function of temperature for many substances.  The 
format is: 
     CALL JANAF(Substance,T: CP,H,S) 
 
More information is available from the Function Info dialog (Options menu).  Click the External Procedure 
button;  Then select JANAF and click the Info button. 
  
> (Version 4.430  6/05/97)  
Lines and/or arrows to the Diagram window using the Add Diagram Line  that has been added to the Options 
Menu.  This command works in exactly the same manner as the Add Line in the Plot menu, except that it 
draws lines or arrows on the Diagram Window. 
 
> (Version 4.423  5/23/97) 
 Make Distributable Program now provides controls which can restrict user access to theTables and Plot 
menus. 
 
> (Version 4.421 05/21/97) 
An Apply button has been provided for the Add Diagram Text command Option menu) and the Add Text 
command (Plot menu) so that multiple  text items can be added to the Diagram window or Plot windows, 
respectively,  with one execution of the command. 
 
> (Version 4.420  05/20/97) 
EES now provides support for string variables.  A string variable is identified with a $ as the last character in 
its name, as in Basic.  String variable can be assigned to string constants which are characters enclosed 
within single quotes.  A string variable can be used wherever character information is normally provided to 
EES.  For example, the following EES equations are now accepted. 
 
  h=enthalpy(R$,T=100,P=200) 
 g=interpolate(F$,Col1$, Col2$, Col1$=h) 
 
 where R$ is a string variable that will be assigned to legal fluid name during execution of the EES program.  
F$ is the name of a Lookup file stored on disk.  Col1$ and Col2$ are string variables for the names of the 
columns in the Lookup table.  String variables can be defined in the Equations Window, in the Parametric 
Table, or in the Diagram Window. 
 
> (Version 4.383 02/28/97)  
The capabilities of the $INCLUDE directive have been expanded to allow library files, as  well as text files to 
be automatically loaded.  EES now provides a Browse option  if the file indicated in the $INCLUDE directive 
can not be found.  
 
> (Version 4.380  02/23/97)  
The Debug window has been changed to provide more useful information.   The Debug window is accessible 
when you try to solve a set of equations which has a different number of  equations than unknowns.   The 
Debug window shows a listing of all variables which are  used only once in the Equations window.   A  
mistyped  variable will often be in this category.  In addition, EES will now try to identify which variables are 
likely to be involved in an overdefined or underdefined problems.  The Residuals window can now be 
accessed even if the solution was not successful.  The Residuals window provides information on the 
blocking and order of solution of the equations which may be useful in debugging your problems. 
 



>Help files provided for external functions and procedures can now be either ASCII help files or  
Windows.HLP files.  In either case, the filename extension should be .HLP.  EES will determine  whether the 
file is a Windows HLP file. 
 
>The Solutions window has been changed to simplify the process of entering units or changing display 
format.  Clicking the left mouse button on a variable name now selects that variable name which is shown in 
inverse video.  To unselect it, click it again.  Multiple variable names can be selected. Pressing the Enter key, 
double-clicking the left mouse button on a variable name or clicking the right mouse button will bring up a 
dialog window in which format specifications can be entered.  These format specifications will be applied to 
ALL selected variables.   
 
>New formatting options have been provided.  Appending _dot to a variable name will cause that variable to 
be displayed in the Formatted Equations, Solution, and Parametric Table with a dot centered over the name.  
For example, T_dot will display as T with a dot centered above the T.  Similarily, T_bar will display a bar 
centered over the T.  T_infinity will display a subscripted infinity symbol.  DELTAT will display the a Greek 
Delta followed by T. 
 
>Clipboard operations have been improved.  When the Solution Window is foremost, the Copy command will 
place a picture of the selected variables in Solution window on the clipboard, as well  as the text version of 
the solution.   You can copy either the text or the picture to another application  using  that application's 
Paste Special command.  Similarly, the selected  equations and comments appearing in the Formatted 
Equations window can be copied as a picture to the Clipboard.  The  Select All will appear as Select Display 
when the Formatted Equations window or the Solution  Window is foremost.  This command will select all 
visible items in the window.  
 
> An Apply button has been added to the Modify Plot dialog window.  Clicking the Apply button shows any 
changes that have been made without exiting the Modify Plot dialog.  The characteristics of  multiple plot 
lines can be made at once in this manner.  The OK button accepts all changes that have been made.  
Cancel restores the plot window to the condition it was in before the Modify Plot dialog was started. 
  
> The MIN and MAX functions formally required two arguments.  They have been modified to  accept 1 or 
more arguments and return the minimum  or maximum value, respectively. 
  
> (Version 4.384  3/3/97)  
A new form for the INTEGRAL function has been implemented which allows differential and integral functions 
to be solved without use of the Parametric table.  The format for the  equation-based INTEGRAL function is:  
y = y0 + INTEGRAL(fxy, x, lowx, highx, stepx).   y0 is the initial value of y.  fxy is an EES variable or 
expression representing the integrand.   The integration variable is x and it is integrated between values lowx 
and highx.  Stepx is optional.  If stepx is not provided, EES will use an automatic-step size adjustment 
algorithm.  The value of the integral is determined numerically.  Additional examples, DRAG.EES, 
SUBSTEPS.EES, and DBL_INTG.EES  have been added to illustrate the use of the INTEGRAL function.  
See the on-line help for a more detailed explanation of the expanded capabilities of the INTEGRAL function. 
 
> Default options for the plots, such as the plot size and axis scale attributes can now be specified in the Plot 
Options section of the Preferences dialog. 
  
> Double-clicking the left mouse button (or clicking the right mouse button) on an equation in the Residuals 
window will cause the Equations window to be moved to the front with the selected equation highlighted. 
 
Ø A new formatting option has been added.  This formatting option, called Automatic, selects the style and 
number of digits depending on the magnitude of the number.  This option should make it unnecessary for the 
user to select Fixed Decimal or Exponential format, except when a particular format is needed.  The 
Automatic formatting option is now the default for any new variables.   Variables defined in problems written 
in older versions of EES will have the  formatting options  selected as previously specified.  The formatting 
option can be changed by clicking on the variable  in the Solutions window or by use of the Variable Info 
command in the Options menu.  If you hold the  Ctrl key down while changing a formatting option, all 
variables below the one being changed will also be changed.  The Automatic formatting option can also be 
used for the numbers on the axes of plots.    
Ø  



> New functions INTERPOLATE and DIFFERENTIATE have been added to provide interpolation or 
numerical differentiation of tabular data.  The data normally reside in the Lookup Table, but these functions 
can also access data in Lookup files or the Parametric table.  The format of the  INTERPOLATE command is 
 
 g = INTERPOLATE('C:myFile',' Col1', 'Col2', Col2=2.34) 
 
The first parameter shown in the above example is optional.  If present, it must be the DOS name of  an 
existing Lookup file previously saved with the Save Lookup Table command.  Col1 and Col2 are  the names 
of the columns from which data are to be interpolate.   The single quotes around the  column name are 
optional.  The final parameter indicates whether a value in the first or second  column is specified.  As shown 
above, an interpolate value from Col1 will be found corresponding to  a value of 2.34 for Col2. 
 
The DIFFERENTIATE command returns d(Col1)/ d(Col2).  It has the same format as the INTERPOLATE 
command.  See the online help for additional information. 
 
 
> Clicking on the column header in the Parametric, Lookup, or Arrays table brings up a dialog window which 
allows the characteristics of that column to be changed.  A new control has been added to this dialog window 
to select the back color for data in the column.  The back color can be used to simply highlight the data, or 
for other purposes, such as to indicate which columns require data input. 
 
> A unit conversions function has been added to EES.   The CONVERT function takes two string  
parameters and returns the factor to convert from the units represented by the first string to that represented 
by the second string.  As an example, the following equation would convert a heat transfer coefficient from 
English to SI units. 
 
      h_SI = h_Eng * Convert('Btu/hr-ft^2-R', 'W/m^2-K') 
 
Note that the single quotes and the ^ symbol are optional.  Additional unit definitions can be added to the 
UNITS.TXT file in the EESW directory.  See the online help for additional information. 
 
>The columns in Parametric table can now be reordered using the Insert/Delete Vars command  in the 
Tables menu.  The order of the columns in the Parametric table is controlled by the order of the variables in 
the Table Variables list.  The order of the variables in the Table Variables list can now be changed using the 
drag and drop feature.  To change the column position of a variable, click on its name and then hold the 
mouse button down while sliding it to a new position. 
 
> It is now possible to control the foreground and background colors of the text displayed in the  Solutions 
window.  To change the color, click on a variable in the Solution window.   A dialog window will appear in 
which the colors can be changed. 
 
> EES can read an ASCII text file (with a .TXT extension) into a Lookup table.  In this case, the first line of 
the file must contain the number of rows and columns in the table.   If a negative number is provided for the 
number of rows, EES will determine the number of rows of data in the file and use that number for creating 
the table.  If the number of columns is a negative number, EES will use the absolute value of this number for 
the number of columns and expect to find the format specification (e.g. F3 or E4)  followed by one space and 
then the column heading and units for each column on following lines .  The units are  enclosed in square 
brackets.  Following lines contain the data for each row, separated by one or more spaces.  The example 
below would create a table with 2 rows  and 3 columns when read in with the Open Lookup command in the 
Tables menu.  The  columns  would be formatted with E4, F0, and F3 format specifications and the column 
names will be ColA,  ColB, and ColC.   
 -1     -3  
E4 ColA [Btu]  
F0 ColB   
F3 ColC  
1.23E-12       2 4.56 2.34E-11       4 7.89 
 
>The MolarMass property function has been implemented.  This function takes one argument, the name of 
the fluid, and returns the molar mass (commonly called the molecular weight).  Here is an example:  
m11=MolarMass(R11) 



 
>EES now offers the option of bar plots.  A bar plot is produced if the plot symbol is chosen to be the open or 
filled bars presented at the bottom of the plot symbol list. 
 
>Suppose you wish to change every occurrence of variable X1 to X_1 to take advantage of  EES's ability to 
display subscripts.  You could do a global change and replace, but then you would also have to reenter the 
guess values, limits, and units for the new variable X_1.  And  if  X1 appears in the Parametric table, you 
would have to remove it and add X_1.  However, there is now an easier way.  You can simply edit the 
variable name in the Variable Info dialog window and EES will make all of these changes for you. 
 
>The Solution Window will now display subscripts and superscripts for units.  For example, m^2 will appear 
with a superscript 2 if the 'Display Subscripts and Greek Symbols' option is selected in the General Display 
section of the Preferences dialog.  An underscore character indicates subscript as in lb_m. 
 
> A Print Preview button has been added to the Print dialog window. 
 
> An Add Legend Item check box has been added to the New Plot and Overlay Plot dialog windows.  If this 
control is checked, a text item will be automatically generated with the name of the Y-axis  variable.  The text 
item will be associated with the line type and symbol selected for the plot line.  The feature makes the 
generation of a plot legend more convenient. The text item is placed at the upper left of the plot.  It can then 
be dragged to any location. 
 
> Clicking the right mouse button in the Equations window will either insert or remove curly brace  comments 
around the selected text.  If the selected text is already commented, i.e., begins with  a left brace and ends 
with a right brace, the comments will be removed - otherwise the braces will be inserted. 
 
>  Previous versions of EES have allowed the user to add fluid property data with the Martin-Hou  equation 
of state as explained in Appendix D.  It is now possible to add additional JANAF table data as well, by 
placing a file with the appropriate coefficients in the USERLIB sub-directory.  The file must have a .IDG 
filename extension.  The file TESTIDG.IDG in the USERLIB sub-directory provides data for CO2 with 
comments to explain the file format.   
 
>  The ERROR procedure now accepts an optional error message string.   See the online help   for the 
syntax and an example.  
 
>  A snap-to-grid option has been provided for moving text on the plot and diagram windows.  The snap to 
grid option is set in the Preferences window.  Holding the Ctrl key down while moving text disables the snap 
to grid option.  
 
>  Internal EES functions and procedures can now make use of the $COMMON  directive to pass information 
from the main program.  The $COMMON statement must follow the FUNCTION or PROCEDURE 
declaration.  The $COMMON directive should be the first item to appear on the line.  Variables appearing in 
the $COMMON statement are separated  with commas, as in this  example. 
 
FUNCTION  TESTCOMMON(X) 
$COMMON B,C,D {variables B,C, and D are from the main program}    TESTCOMMON:=X+B+C+D 
 END 
 B=4;  C=5;  D=6 
 G=TESTCOMMON(3) 
  
 
 
 


